
 

  
 

Agilent BioTek Epoch 
 
Absorbance Microplate 
Spectrophotometer 
 

 

 

 

INSTRUCTIONS FOR USE 
 
 
 

 
 

 

ERRATA NOTICE: This document 
contains references to BioTek.  
Please note that BioTek is now 
Agilent. For more information, go to 
www.agilent.com/lifesciences/biotek. 

 

Document part number 7201009I 
Revision C 

Agilent Technologies, Inc. 
May 2022 

         For In Vitro Diagnostic Use    

 



 Page 2 of 31 
 

Agilent BioTek Epoch Instructions for Use  Agilent Technologies, Inc. 
7201009I Revision C 

Contents 
 

Preface ................................................................................................................................. 3 

Copyright .......................................................................................................................... 3 

All Rights Reserved ................................................................................................... 3 

Contact Information ......................................................................................................... 3 

Worldwide Sales and Support.................................................................................. 3 

Technical Support and Service ................................................................................. 3 

Customer Care ......................................................................................................... 3 

European Coordination Center ................................................................................ 3 

UK Responsible Person (UKRP) ................................................................................ 4 

Intended Use Statement .................................................................................................. 4 

Incident Reporting ............................................................................................................ 4 

Quality Control ................................................................................................................. 4 

Safety Notices ................................................................................................................... 4 

Warnings and Precautions ............................................................................................... 5 

Electrical Hazards ..................................................................................................... 5 

Chemical/Environmental ......................................................................................... 5 

Components ............................................................................................................. 6 

Intended Product Use .............................................................................................. 6 

Symbols ............................................................................................................................ 7 

Conformance to Standards .............................................................................................. 9 

EMC Information and Technical Description ................................................................. 10 

Ingress Protection Code ................................................................................................. 10 

Disposal .......................................................................................................................... 10 

Installation ......................................................................................................................... 11 

Important Information ................................................................................................... 11 

Package Contents ........................................................................................................... 11 

Models ............................................................................................................................ 11 

Unpack the Box .............................................................................................................. 12 

Remove the Shipping Hardware .................................................................................... 13 

Select an Appropriate Location ...................................................................................... 14 

Install the Power Supply ................................................................................................. 14 

Prepare the Host Computer ........................................................................................... 14 

Connect the Host Computer and Reader ....................................................................... 15 

Turn on the Reader ........................................................................................................ 15 

Establish Communication ............................................................................................... 15 

Troubleshooting ..................................................................................................... 15 

Verify Performance ........................................................................................................ 16 



Preface Page 3 of 31 

Agilent BioTek Epoch Instructions for Use  Agilent Technologies, Inc. 
7201009I Revision C 

Repackaging and Shipping Instructions ......................................................................... 17 

Install the Shipping Hardware ........................................................................................ 17 

Repackage the Instrument and Accessories .................................................................. 18 

Getting Started ................................................................................................................... 19 

Maintenance ...................................................................................................................... 20 

Warnings and Precautions ............................................................................................. 20 

Schedule ......................................................................................................................... 21 

Clean Exposed Surfaces .................................................................................................. 21 

Decontamination ............................................................................................................ 21 

Required Materials ................................................................................................ 21 

Procedure ............................................................................................................... 22 

Instrument Testing ............................................................................................................. 23 

Schedule ......................................................................................................................... 23 

System Test .................................................................................................................... 23 

Absorbance Tests ........................................................................................................... 23 

Description ............................................................................................................. 23 

Test Plate Certificates ............................................................................................ 23 

Define the Absorbance Test Plate Parameters ...................................................... 24 

Procedure ............................................................................................................... 24 

Specifications ..................................................................................................................... 25 

General Specifications .................................................................................................... 25 

Read Specifications......................................................................................................... 26 

Optical Performance ...................................................................................................... 27 

 

 

 

 

 

 





Preface Page 3 of 31 

Agilent BioTek Epoch Instructions for Use  Agilent Technologies, Inc. 
7201009I Revision C 

Preface 

Copyright 

All Rights Reserved 

© Agilent Technologies, Inc. 2021, 2022. No part of this manual may be reproduced in 
any form or by any means (including electronic storage and retrieval or translation into a 
foreign language) without prior agreement and written consent from Agilent 
Technologies, Inc. as governed by United States and international copyright laws. 

Contact Information 

 

Agilent Technologies, Inc. 
5301 Stevens Creek Blvd. 
Santa Clara, CA  95051 

Worldwide Sales and Support 

www.agilent.com/en/contact-us/page 

Technical Support and Service 

www.agilent.com/en/support 

bio.tac@agilent.com 

Instrument service and repair is available worldwide at one of our international service 
centers and in the field at your location. 

Customer Care 

bio.CustomerCare@agilent.com 

European Coordination Center 

 
Agilent Technologies Denmark ApS 
Produktionsvej 42, 2600 Glostrup, Denmark 
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UK Responsible Person (UKRP) 

 Agilent LDA UK Ltd. 
5500 Lakeside 
Cheadle Royal Business Park 
Cheadle, Cheshire SK8 3GR 

Intended Use Statement 

The Epoch is an absorbance microplate spectrophotometer and intended to be used for 
the examination of clinical specimens to analyze their characteristics in relation to a variety 
of analytes including in human serum and cells. 

Incident Reporting 

Any serious incident that has occurred in relation to the device shall be reported to the 
manufacturer and the competent authority, or appropriate regulatory body, in the country 
or region in which the user is established. 

Quality Control 

It is considered good laboratory practice to run laboratory samples according to 
instructions and specific recommendations included in the assay package insert for the 
test to be conducted. Failure to conduct Quality Control checks could result in erroneous 
test data. 

Safety Notices 

Pay special attention to the following safety notices in all product documentation.  

-WARNING- A WARNING notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like that, if not correctly performed or adhered 
to, could result in personal injury or death. Do not proceed beyond a 
WARNING notice until the indicated conditions are fully understood and 
met. 

-CAUTION- A CAUTION notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like that, if not correctly performed or adhered 
to, could result in damage to the product or loss of important data. Do not 
proceed beyond a CAUTION notice until the indicated conditions are fully 
understood and met. 
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Warnings and Precautions 

Electrical Hazards 

-WARNING- Internal Voltage. Always turn off the power switch and unplug the power 
supply before cleaning the outer surface of the instrument. 

-WARNING- Power Rating. The instrument’s power supply or power cord must be 
connected to a power receptacle that provides voltage and current within 
the specified rating for the system. Use of an incompatible power 
receptacle may produce electrical shock and fire hazards. 

-WARNING- Electrical Grounding. Never use a plug adapter to connect primary power 
to the external power supply. Use of an adapter disconnects the utility 
ground, creating a severe shock hazard. Always connect the power cord 
directly to an appropriate receptacle with a functional ground. 

-WARNING- Service. Only qualified technical personnel should perform service 
procedures on internal components. 

-CAUTION- Power Supply. Use only the power supply shipped with the instrument, 
and operate it within the range of line voltages listed on it. 

Chemical/Environmental 

-WARNING- 

 

Potential Biohazards. Some assays or specimens may pose a biohazard. 
Adequate safety precautions should be taken as outlined in the assay’s 
package insert. Always wear safety glasses and appropriate protective 
equipment, such as chemical-resistant rubber gloves and apron. 

-WARNING- Liquids. Avoid spilling liquids on the instrument; fluid seepage into 
internal components creates a potential for shock hazard or instrument 
damage. If a spill occurs while a program is running, stop the program and 
turn off the instrument. Wipe up all spills immediately. Do not operate the 
instrument if internal components have been exposed to fluid. 

-CAUTION- Liquids. Do not immerse the instrument, spray it with liquid, or use a 
dripping-wet cloth on it. Do not allow water or other cleaning solution to 
run into the interior of the instrument. If this happens, contact Technical 
Support. 

-CAUTION- Environmental Conditions. Do not expose the instrument to temperature 
extremes. For proper operation, temperature near the instrument should 
remain within the range in the Specifications section of this document. 
Performance may be adversely affected if temperatures fluctuate above 
or below this range 

-CAUTION- Sodium Hypochlorite. Do not expose any part of the instrument to the 
recommended diluted sodium hypochlorite solution for more than 20 
minutes. Prolonged contact may damage the instrument surfaces. Be 
certain to rinse and thoroughly wipe all surfaces. 
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-CAUTION- Lubricants. Do not apply lubricants to moving parts. Lubricant on 
components in the carrier compartment will attract dust and other 
particles, which may cause the instrument to produce an error. 

Components 

-WARNING- Accessories. Only accessories that meet the manufacturer's specifications 
shall be used with the instrument. 

-CAUTION- Shipping Hardware. All shipping hardware must be removed before 
operating the instrument and reinstalled before repackaging the 
instrument for shipment. 

-CAUTION- Spare Parts. Only approved spare parts should be used for maintenance. 
The use of unapproved spare parts and accessories may result in a loss of 
warranty and potentially impair instrument performance or cause damage 
to the instrument. 

-CAUTION- Service. Only qualified technical personnel should perform service 
procedures on internal components. 

Intended Product Use 

-WARNING- Software Quality Control. The operator must follow the manufacturer’s 
assay package insert when modifying software parameters and 
establishing reading methods. It is considered good laboratory practice to 
run laboratory samples according to instructions and specific 
recommendations included in the assay package insert for the test to be 
conducted. Failure to conduct quality control checks could result in 
erroneous test data. 

-WARNING- Data Reduction. No limits are applied to the raw measurement data. Data 
exported via computer control must be analyzed by the operator. The 
performance characteristics of the data reduction software have not been 
established with any laboratory diagnostic assay. Users must evaluate this 
instrument and PC-based software in conjunction with their specific 
assay(s). This evaluation must include the confirmation that performance 
characteristics for the specific assay(s) are met. 

-WARNING- Unspecified Use. Failure to operate equipment according to the guidelines 
and safeguards specified in the product user documentation could result 
in a hazardous condition. 

-CAUTION- Use of labware other than described in this document can result in 
positioning errors during program execution. 
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Symbols 

 

Caution 

 

Warning; Biological hazard 

 

Disposal Notice: Dispose of the instrument according to Directive 
2012/19/EU, “on waste electrical and electronic equipment (WEEE)” or 
local ordinances 

 
Consult instructions for use or consult electronic instructions for use 

 
In vitro diagnostic medical device 

 

CE Marking — indicates compliance with the requirements of the In Vitro 
Diagnostic Regulation (2017/746) 

 

Authorized representative in the European Community/European Union 

 
Manufacturer 

 

Date of manufacture 

 
Catalogue number 

 
Serial number 

 

TÜV SÜD Certification Mark – Type tested; production monitored 

IP20 Ingress Protection - Product protected against solid objects up to 12 
millimeters. Not protected from liquids. 

 

This product complies with environmental protection use period as 
defined in People’s Republic of China Electronic Industry Standard 
SJ/T11364-2006. Toxic or hazardous substances will not leak or mutate 
under normal operating conditions for 40 years. 

 

UK Conformity Assessed marking is a certification mark that indicates 
conformity with the applicable requirements for products sold 
within Great Britain. 
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Temperature limit  

 

Humidity limitation  

 

 
Unique device identifier 

 
Model number 

 

Importer 
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Conformance to Standards 

The Epoch meets the requirements of the following standards: 

2014/35/EU – Low Voltage Directive  
2014/30/EU – EMC Directive 
2017/746 – In Vitro Diagnostic Regulation 
2011/65/EU (with exemptions) and (EU) 2015/863 – RoHS Directives 
2012/19/EU – WEEE Directive as amended by (EU) 2018/849 

2006/42/EC of the European Parliament and of the Council of 17 May 2006 on 
machinery 

 

Standard Description 

IEC QC 080000 IEC Quality Assessment System for Electronic 
Components (IECQ System) - Hazardous Substance 
Process Management (HSPM) System Requirements 

UL 61010-1 UL Standard for Safety Electrical Equipment For 
Measurement, Control, and Laboratory Use; Part 1: 
General Requirements 

EN 61010-1 Safety Requirements for Electrical Equipment For 
Measurement, Control, and Laboratory Use – Part 1: 
General Requirements 

EN 61010-2-081 Safety Requirements for Electrical Equipment For 
Measurement, Control, and Laboratory Use – Part 2-081: 
Particular requirements for automatic and semi-
automatic laboratory equipment for analysis and other 
purposes 

EN 61010-2-101 Safety Requirements for Electrical Equipment For 
Measurement, Control, and Laboratory Use – Part 2-101: 
Particular requirements for in vitro diagnostic (IVD) 
medical equipment  

CAN/CSA C22.2 No. 61010-1 Safety Requirements for Electrical Equipment For 
Measurement, Control, and Laboratory Use – Part 1: 
General Requirements 

CAN/CSA C22.2 No. 61010-2-081 Safety Requirements for Electrical Equipment For 
Measurement, Control, and Laboratory Use – Part 2-081: 
Particular requirements for automatic and semi-
automatic laboratory equipment for analysis and other 
purposes 

CAN/CSA C22.2 No. 61010-2-101 Safety Requirements for Electrical Equipment For 
Measurement, Control, and Laboratory Use – Part 2-101: 
Particular requirements for in vitro diagnostic (IVD) 
medical equipment  
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EMC Information and Technical Description 

The Epoch conforms to: 

Emissions: 

EN55011/CISPR 11, Class A 
CFR Title 47 FCC Part 15 Subpart B, Class A 
ICES-001, Issue 5, Class A (CAN ICES-001(A)/NMB-001(A)) 
ACMA AS/NZS CISPR 11, Class A 

Immunity: 

EN/IEC 61326-1 and 61326-2-6 
ELECTRICAL EQUIPMENT FOR MEASUREMENT, CONTROL AND LABORATORY USE 
PART 2-6: PARTICULAR REQUIREMENTS FOR (IVD) MEDICAL EQUIPMENT 

Ingress Protection Code 

IP 20. Protected against solid foreign objects of 12.5 mm diameter and greater. No 
protection against water. 

Disposal 

Dispose of the instrument according to Directive 2012/19/EU, “on waste electrical and 
electronic equipment (WEEE)” or local ordinances. 
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Installation 
 

Important Information 

-CAUTION- Shipping Hardware. All shipping hardware must be removed before 
operating the instrument and reinstalled before repackaging the 
instrument for shipment. 

• This chapter contains installation and setup tasks for the Epoch and accessories. 
Perform the tasks in the order presented. 

• Save all packaging materials. Be sure to use packaging materials supplied by the 
manufacturer when shipping the reader. Using other forms of commercially 
available packaging, or failing to follow the repackaging instructions, may void your 
warranty. 

• During the unpacking process, inspect the packaging, reader, and accessories for 
shipping damage. If the reader is damaged, notify the carrier and your Agilent 
representative. Keep the shipping boxes and the packaging materials for the 
carrier's inspection. 

Package Contents  

• Epoch instrument model per the sales order 
• Epoch User Manual on USB flash drive 
• Power supply 
• Power cord  
• USB cable  
• Software and optional accessories per the sales order, unless shipped separately 

Models 

Part Number Features 

EPOCH-SI   Microplate Spectrophotometer. 
EPOCHH-SI  Microplate Spectrophotometer for high-altitude sites. 
EPOCHR-SI   Microplate Spectrophotometer. BioStack and 3rd party compatible. 
EPOCHRH-SI  Microplate Spectrophotometer for high-altitude sites. BioStack and  
    3rd party compatible. 
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Unpack the Box 

 

Save the packaging, in case you need to ship the instrument for service/repair. 

 

User manual 

Take3 plate 

USB cable 

Power cable 

Power supply 

Gen5 
software 



Installation Page 13 of 31 

Agilent BioTek Epoch Instructions for Use  Agilent Technologies, Inc. 
7201009I Revision C 

Remove the Shipping Hardware   

-CAUTION- Shipping Hardware. All shipping hardware must be removed before 
operating the instrument and reinstalled before repackaging the 
instrument for shipment. 

 

1. See Figure 1. Remove the shipping screw, o-ring, and rubber plug. 

2. See Figure 2. Install the plug in the hole where the shipping screw was originally 
located, and insert the screw and o-ring in the hole where the plug was originally 
located. The plug prevents light from entering the reading chamber during 
operation. 

 

Figure 1 

 

 

Figure 2 

 

Shipping screw 
and o-ring  

Plug  

Plug  

Shipping screw 
and o-ring  
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Select an Appropriate Location  

Install the reader on a level, stable surface in an area where an operating temperature 
between 18°C and 40°C can be maintained.  

The reader is sensitive to extreme environmental conditions. Avoid: 

• Excessive humidity. Condensation directly on the sensitive electronic circuits can 
cause the instrument to fail internal self-checks. The humidity must be in the range 
described in the Specifications section. 

• Excessive ambient light. Bright light may affect the reader’s optics and readings, 
reducing its linear range. 

• Dust. Readings may be affected by extraneous particles in the microplate wells. A 
clean work area is necessary to ensure accurate readings. 

Install the Power Supply 

-WARNING- Power Rating. The instrument’s power supply or power cord must be 
connected to a power receptacle that provides voltage and current within 
the specified rating for the system. Use of an incompatible power 
receptacle may produce electrical shock and fire hazards. 

-WARNING- Electrical Grounding. Never use a plug adapter to connect primary power 
to the external power supply. Use of an adapter disconnects the utility 
ground, creating a severe shock hazard. Always connect the power cord 
directly to an appropriate receptacle with a functional ground. 

-CAUTION- Power Supply. Use only the power supply shipped with the instrument, 
and operate it within the range of line voltages listed on it. 

 

1. Connect the power cord to the external power supply. 

2. Locate the power inlet on the rear of the reader. 

3. Plug the rounded end of the power supply's cord into the power inlet. 

4. Plug the other end of the power cord into an appropriate power receptacle. 

Prepare the Host Computer 

Follow instructions supplied with Gen5 to install the necessary software. 

• Ensure the computer meets the minimum system requirements as described in the 
Gen5 Instructions for Use. 

• You must have administrator privileges to install Gen5. Log in to Windows as 
“Administrator” or consult your IT department for assistance. 
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Connect the Host Computer and Reader 

1. Turn off the computer. 

2. Using the supplied USB cable, connect the square end of the cable to the USB port 
on the rear of the reader. 

3. Connect the other end of the cable to an available USB port on the computer. 

4. Turn on the computer. 

Turn on the Reader  

1. Locate the power on/off switch on the front of the instrument, next to the carrier 
eject button. The power on/off switch has a green, internal LED lamp that is 
illuminated when the power is on. The carrier eject button, when pressed, ejects 
the carrier out of the reader or pulls the carrier back inside the reader to the 
carrier home position. 

2. Turn on the power. The reader will perform an internal self-test and carrier 
homing sequence. The carrier will eject outside the reader, then retract to its 
home position inside the reader before it ejects again. Ensure that the reader 
performs the carrier homing sequence and that the LED light is illuminated while 
the power is on.  

If the test is successful, the reader is ready for use. If the test fails, contact 
Technical Support.  

Establish Communication 

On the host computer, start Gen5 and log in if prompted. 

1. From the main screen, select System > Instrument Configuration and click Add. 

2. Set the Reader Type to Epoch. 

3. Perform one of the following steps, as applicable: 

• Select Plug & Play. 

• Set the Com Port to the computer's COM port to which the reader is 
connected.  

4. To verify that Gen5 can communicate with the instrument, click Test Comm.  

Troubleshooting 

If the communication attempt is successful, Gen5 displays a success message. Return to 
the main screen. If the communication attempt is not successful, try the following: 

• Is the reader connected to the power supply and turned on? 

• Is the communication cable firmly attached to both the reader and the 
computer? 
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• Did you select the correct Reader Type/instrument in Gen5? 

• Try a different COM Port or use Plug & Play. 

• Did you install the USB driver software? 

If you remain unable to get Gen5 and the reader to communicate with each other, 
contact Technical Support. 

Verify Performance 

Refer to the Instrument Testing section for Absorbance Test procedures. 

 



Installation Page 17 of 31 

Agilent BioTek Epoch Instructions for Use  Agilent Technologies, Inc. 
7201009I Revision C 

Repackaging and Shipping Instructions 

Please read the information provided below before preparing the Epoch for shipment. 

• Contact Technical Support before returning equipment for service.  

• Decontamination prior to shipment is required by the U.S. Department of 
Transportation regulations. 

• If the Epoch has been exposed to potentially hazardous material, decontaminate it 
to minimize the risk to all who come in contact with the instrument during 
shipping, handling, and servicing. The Maintenance chapter contains 
decontamination instructions. 

• Ensure the microplate carrier is empty. Spilled fluids can contaminate the optics 
and damage the instrument. 

• Install the shipping hardware (see next section). 

• The instrument’s packaging design is subject to change. If the instructions in this 
document do not apply to the packaging materials you are using, contact Technical 
Support for guidance. 

• Be sure to use packaging materials supplied by the manufacturer. Other forms of 
commercially available packaging are not recommended and can void the warranty. 

• If the packaging materials have been damaged or lost, or if the same set has been 
used more than four times, order replacement part number 7203003. 

• The shipping box, accessories box, foam caps, and other items are included as a 
whole set under this part number and cannot be ordered separately. 

Install the Shipping Hardware 

-CAUTION- Shipping Hardware. All shipping hardware must be removed before 
operating the instrument and reinstalled before repackaging the 
instrument for shipment. 

 
1. If you have not already done so, retract the microplate carrier. 

2. Turn off the reader, and unplug the power supply from the power outlet and 
from the power supply connector on the back of the reader. Remove the USB 
cable from the reader. 

3. Using a screwdriver, remove the shipping screw and o-ring from the reader, and, 
using your fingers, remove the plug from the reader. 

4. Insert the plug in its original hole and use the screwdriver to re-install the 
shipping screw and o-ring in its original position. 
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Repackage the Instrument and Accessories 

Refer to the drawing on page 12. 

1. Place the foam cap into the bottom of the shipping container. Note the 
orientation of the foam cap in the box. 

2. Place the accessories box back into the shipping container. 

3. Place the reader inside the original plastic bag and carefully lower the reader into 
the two foam caps in the bottom of the box. Note the orientation of the reader 
in the box. 

4. Place two foam caps over the reader. 

5. Bundle the power cord and place it into the accessories box as shown. 

6. Place the power supply and USB cable in the accessories box. 

7. Close the top of the box and secure it with shipping tape. 
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Getting Started 
Gen5 software supports all Epoch reader models. This section provides brief instructions 
for creating a protocol and running an experiment. For more information, refer to 
publications provided with Gen5 and the Gen5 help system (Help > Help Topics). 

In Gen5, a protocol contains instructions for controlling the reader and (optionally) 
instructions for analyzing the data retrieved from the reader. At a minimum, a protocol 
must specify the procedure you wish to run. After creating a protocol, create an 
experiment that references the protocol. You will run the experiment to read plates and 
analyze the data. 

1. In the Gen5 Task Manager, select Protocol > Create New. 

2. Open the Procedure dialog. If prompted to select a reader, select Epoch and click 
OK. 

3. Select a Plate Type. 

Gen5 stores measurements and other characteristics for individual plate types in a 
database. It is essential that you select (or define) the plate type to match the assay 
plate. Otherwise, results may be invalid. See the “Plate Type Database” topic in the 
Gen5 Help for instructions. 

4. Add steps to the procedure for reading the plate. Click Validate to verify that the 
reader supports the defined steps, and then click OK. 

5. Optionally, perform any of these steps to analyze and report the results: 

• Open the Plate Layout dialog and assign blanks, samples, controls, and/or 
standards to the plate. 

• Open the Data Reduction dialog to add data reduction steps. Categories 
include Transformation, Well Analysis, Curve Analysis, and Qualitative 
Analysis. 

• Create a report or export template via the Report/Export Builders. 

6. Select File > Save and give the protocol an identifying name. 

7. In the Gen5 Task Manager, select Experiment > Create using an existing 
protocol.  

8. Select the desired protocol and click OK. 

9. Select a plate in the menu tree and click . 

10. When the read is complete, measurement values appear in Gen5. Select the 
desired data set from the Data list. 

11. Select File > Save and give the experiment an identifying name. 
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Maintenance 
 

Warnings and Precautions 

-WARNING- Internal Voltage. Always turn off the power switch and unplug the power 
supply before cleaning the outer surface of the instrument. 

-WARNING- Liquids. Avoid spilling liquids on the instrument; fluid seepage into 
internal components creates a potential for shock hazard or instrument 
damage. If a spill occurs while a program is running, stop the program and 
turn off the instrument. Wipe up all spills immediately. Do not operate the 
instrument if internal components have been exposed to fluid. 

-CAUTION- Liquids. Do not immerse the instrument, spray it with liquid, or use a 
dripping-wet cloth on it. Do not allow water or other cleaning solution to run 
into the interior of the instrument. If this happens, contact Technical 
Support. 

-CAUTION- Lubricants. Do not apply lubricants to moving parts. Lubricant on 
components in the carrier compartment will attract dust and other particles, 
which may cause the instrument to produce an error. 

-WARNING- 

 

Potential Biohazards. Wear protective gloves when handling contaminated 
instruments. Gloved hands should be considered contaminated at all times; 
keep gloved hands away from eyes, mouth, nose, and ears. 

Mucous membranes are considered prime entry routes for infectious agents. 
Wear eye protection and a surgical mask when there is a possibility of 
aerosol contamination. Intact skin is generally considered an effective barrier 
against infectious organisms; however, small abrasions and cuts may not 
always be visible. Wear protective gloves when handling contaminated 
instruments. 
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Schedule 

Task Frequency 

Clean exposed surfaces As needed 

Decontamination Before shipment, storage, or disposal 

Clean Exposed Surfaces 

A regular cleaning regimen is recommended to keep the instrument free from dust and 
particulates that can cause erroneous readings. Exposed surfaces may be cleaned (not 
decontaminated) with a cloth moistened (not soaked) with water or water and a mild 
detergent. 

1. Turn off and unplug the instrument from the power supply.  

2. Moisten a clean, lint-free disposable cloth with water, or with water and mild 
detergent, then thoroughly wring it out so that liquid does not drip from it. Do 
not soak the cloth.  

3. Wipe the plate carrier and all exposed surfaces of the instrument.  

4. If detergent was used, wipe all surfaces with a cloth moistened, not soaked, with 
water. 

5. Use a clean, dry, lint-free cloth to dry all wet surfaces. 

If liquid is spilled inside the reader, contact Technical Support. 

Decontamination 

• The Epoch requires decontamination prior to shipping, storage, and disposal. 

• Decontamination is required by the U.S. Department of Transportation regulations. 

• Persons performing the decontamination process must be familiar with the basic 
setup and operation of the instrument. 

• Agilent recommends the use of the following decontamination solutions and 
methods based on our knowledge of the instrument and recommendations of the 
Centers for Disease Control and Prevention (CDC). Neither Agilent nor the CDC 
assumes any liability for the adequacy of these solutions and methods. Each 
laboratory must ensure that decontamination procedures are adequate for the 
biohazard(s) they handle. 

Required Materials 

• Sodium hypochlorite (NaClO) 
• 70% isopropyl alcohol (as an alternative to sodium hypochlorite) 
• Deionized or distilled water 
• Safety glasses 
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• Surgical mask 
• Protective gloves 
• Lab coat 
• Biohazard trash bags 
• 125-mL beakers 
• Clean, lint-free cotton cloths 

Procedure 

1. Turn off and unplug the reader from the power supply. 

2. Prepare a disinfecting solution: an aqueous solution of 0.5% sodium hypochlorite 
(NaClO). If the effects of sodium hypochlorite are a concern, 70% isopropyl 
alcohol may be used. 

3. Moisten a clean, lint-free cloth with the disinfecting solution, then thoroughly 
wring it out so that liquid does not drip from it. Do not soak the cloth. 

4. Wipe the plate carrier and all exposed surfaces of the instrument. 

5. Wait 20 minutes. 

6. Moisten a cloth with deionized or distilled water and wipe all surfaces of the 
instrument that have been cleaned with the disinfecting solution. 

7. Use a clean, dry lint-free cloth to wipe all wet surfaces. 

8. Discard the used gloves and cloths, using a biohazard trash bag and an approved 
biohazard container. 
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Instrument Testing 
 

Schedule 

Recommendations for an Epoch used two to five days per week: 

Test Frequency 

System Test Monthly 

Absorbance Tests Monthly 

System Test 

Each time the Epoch is turned on, it automatically performs a series of tests on the 
reader’s motors, lamp, and various subsystems. This test can take a few minutes to 
complete. If all tests pass, the microplate carrier is ejected and the green LED on the 
power switch remains on. 

If any test results do not meet the internally coded Failure Mode Effects Analysis (FMEA) 
criteria, the reader beeps repeatedly and the green LED on the power switch flashes. If this 
occurs, press the carrier eject button to stop the beeping.   

1. Turn on the reader and launch Gen5.  

2. Select System > Diagnostics > Run System Test.  

3. When the test is complete, a dialog appears, requesting additional information. 
Enter your user name and other information (if desired), and then click OK. 

4. The results report appears. It should show “SYSTEM TEST PASS”. If it shows  
“SYSTEM TEST FAIL” contact Technical Support. 

Absorbance Tests 

Description 

This test uses the 7-Filter Absorbance Test Plate (Part Number 7260522) to confirm the 
mechanical alignment; optical density accuracy, linearity, and repeatability; and 
wavelength accuracy to NIST-traceable values. The Absorbance Plate Test compares the 
reader’s optical density and wavelength measurements to NIST-traceable values. 

Test Plate Certificates   

To run this test on the Epoch, you will need the 7-Filter Absorbance Test Plate (Part 
Number 7260522) with its accompanying certificates. 
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Define the Absorbance Test Plate Parameters 

1. Obtain the certificates that came with the Test Plate. 

2. Start Gen5. From the main screen, click System > Diagnostics > Test Plates > 
Add/Modify Plates.  

3. Click Add/Add Plate. The Absorbance Test Plate dialog appears. 

4. Select the appropriate plate type and enter the plate’s serial number. 

5. Enter the last and next certification dates, found on the calibration sticker on the 
Test Plate. Click Help for guidance when setting the wavelengths and entering 
the OD and peak wavelength values. 

6. Review the values you entered, and then click OK to save the data. The 
wavelengths and corresponding calibration data that have been entered will now 
be available in Gen5 each time the Absorbance Plate Test is performed. 

Procedure 

1. From the main screen, click System > Diagnostics > Test Plates > Run.  

2. If prompted, select the desired Test Plate and click OK. 

3. When the Absorbance Test Plate Options dialog appears, select Perform Peak 
Wavelength Test, if it is not already selected. 

4. Highlight the wavelength or wavelengths to be included in this test. Select only 
those wavelengths that are most appropriate for your use of the reader. Enter 
any comments, if desired. 

5. Click Start Test. 

6. Place the Test Plate in the microplate carrier so that well A1 is in the left-rear 
corner of the carrier (as you are facing the carrier). 

7. Click OK to run the test. 

8. When the test is completed, the results report appears. Scroll through the 
report; every result should show PASS. If any result shows “FAIL”, try the 
following and rerun the test. If the test continues to fail, contact Technical 
Support. 

 Make sure the information entered into Gen5 matches the Test Plate’s 
Certificate. 

 Verify that the Test Plate is within its calibration certification period. If it is 
out of date, contact Technical Support to schedule a recertification. 

 Ensure that the Test Plate is correctly seated in the microplate carrier. 
 Check the alignment (corner) holes on the Test Plate to ensure they are clear 

of debris. 
 Check the filters on the Test Plate to ensure they are clean. If necessary, 

clean them with lens paper. Do not remove the filters from the test plate. Do 
not use alcohol or other cleaning agents. 
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Specifications 
 

 

General Specifications 

Microplates 

The Epoch accommodates standard 6-, 12-, 24-, 48-, 96-, and 384-well microplates with 
128 x 86 mm geometry; and the Take3 and Take3 Trio Micro-Volume Plates. 

 
Hardware and Environmental 

Light Source Xenon flash light source 

Dimensions 31.8 cm D x 30.5 cm W x 19.6 cm H 

Weight < 6.804 kg (without power supply) 

Environment Operational temperature 18°C to 40°C 

Storage temperature range: -25°C to 50°C 

Humidity Operational: Maximum relative humidity of 80% at 
temperatures up to 31°C decreasing linearly to 50% relative 
humidity at 40° C (non-condensing) 

Storage: 10% to 80% relative humidity (non-condensing) 

Power Supply 24-volt external power supply compatible with 100–240 V~; +/- 
10% @50–60 Hz  

Power Consumption < 40W  
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Read Specifications 

All read speeds are +/– 2 seconds. 

 

Endpoint Measurements 

96 Well 

Mode Delay Time 630 nm 630/450 nm 

Normal 100 msec 49 95 

Rapid 0 msec 38 75 

Sweep N/A 15 30 

384 Well 

Mode Delay Time 630 nm 630/450 nm 

Normal 100 msec 169 333 

Rapid 0 msec 131 257 

Sweep N/A 31 56 

 

Kinetic Measurements 

96 Well 

Mode Delay Time 630 nm 

Normal 100 msec 50 

Rapid 0 msec 42 

Sweep N/A 13 

Mode Delay Time 630 nm 

Normal 100 msec 169 

Rapid 0 msec 129 

Sweep N/A 30 
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Optical Performance  

Accuracy, Linearity, Repeatability 

All qualifications were conducted using 96-/384-well, flat-bottom microplates.  

For the performance described here, the Gain on the Optics Test should be <= 8. 

Measurement Range: 0.000 to 4.000 OD                   Resolution: 0.0001 OD 

Accuracy, NIST Filters 

96-well plate, normal read speed, 100-ms delay after plate movement 

0.000–2.000 OD +/-1% +/-0.010 OD 
2.000–2.500 OD +/-3% +/-0.010 OD 

384-well plate, normal read speed, 100-ms delay after plate movement 

0.000–1.500 OD +/-2% +/-0.010 OD 
1.500–2.000 OD +/-5% +/-0.010 OD 

96-well and 384-well plate, sweep read speed 

0.000–1.000 OD +/-1% +/-0.010 OD  

Linearity 

96-well plate, normal read speed, 100-ms delay after plate movement 

0.000–2.000 OD +/-1% +/-0.010 OD 
2.000–2.500 OD +/-3% +/-0.010 OD 

384-well plate, normal read speed, 100-ms delay after plate movement 

0.000–1.500 OD +/-2% +/-0.010 OD 
1.500–2.000 OD +/-5% +/-0.010 OD 

96-well and 384-well plate, sweep read speed 

0.000–1.000 OD +/-1% +/-0.010 OD 

Repeatability, NIST Filters, Standard Deviation 

96-well plate, normal read speed, 100-ms delay after plate movement 

0.000–2.000 OD +/-1% +/-0.005 OD 
2.000–2.500 OD +/-3% +/-0.005 OD 

384-well plate, normal read speed, 100-ms delay after plate movement 

0.000–1.500 OD +/-1% +/-0.005 OD 
1.500–2.000 OD +/-3% +/-0.005 OD 

96-well and 384-well plate, sweep read speed 

0.000–1.000 OD +/-2% +/-0.010 OD 
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Optics 

λ range 200 to 999 nm   

λ accuracy ± 2 nm  

λ repeatability ± 0.2 nm  

λ bandpass < 5 nm  

Detector Photodiodes (2) 
 

 



 

In This Book 
 
This document contains installation, operation, maintenance, and qualification 
information for all models of the Epoch. 
 

Document Revision History 

Part 
Number Revision Date Modifications 

7201009I C May 2022 Added Agilent brand information.  

Updated content and symbols to support 2017/746 – 
In Vitro Diagnostic Regulation. 

Replaced the Notices section with Copyright 
information. 

Added Customer Care contact information. 

Removed the Warranty and Product Registration 
section. 

 
Original Language – EN 
 

 

Manufactured by Agilent Technologies, Inc. 
5301 Stevens Creek Blvd. 
Santa Clara, CA  95051 
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